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Abstract 

This document is provided for authors who submit to the International Journal of Microgravity Science and Application (IJMSA). The 
authors do not need to remember a little complicated special JASMA styles in the old template since the new ‘IJMSA’ ribbon tab is added. 
Please pay attention that buttons in the ‘IJMSA’ tab will correctly work only if the authors use MS-Word 2010 or later versions. Otherwise, 
some functions may not work correctly. The authors write plain texts first and then press an appropriate button second. Some buttons may 
require range selection by dragging a mouse or using ‘Shift+Cursor’ keys or require appropriate cursor positions. The authors must pay 
attention that the length of abstract must be within 910 characters. If you exceed that limitation, a warning will be popped up when you press 
the ‘Abstract’ button. 

Keyword(s): keyword1, keyword2, … keywords are described here. 
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1. Introduction 

Since authors must provide a manuscript with appropriate 
styles for the Int. J. Microgravity Sci. Appl. (IJMSA), the 
authors may pay excess attention to a layout of manuscript. 
Although JASMA styles are defined to help the authors in the 
older template, it may be a little complicated to use the styles. 
Therefore, the editorial board supplies a new method, that is, a 
new ribbon tab. First, you open a new MS-Word document. 
Then go to the ‘Developer’ tab in the ribbon. If you do not see 
the tab, go to ‘Options’, select ‘Customize Ribbon,’ and enable 
the ‘Developer’ checkbox in the right side panel of the ‘Main 
Tabs.’ Then go to the ‘Developer’ tab and select ‘Document 
Template’ button. A dialog box named ‘Template and Add-ins’ 
will appear. You must replace the ‘Normal’ template in the 
‘Document template’ box to ‘JASMA.dotm’ by clicking 
‘Attach...’ button. There is no limitation of the location where 
the template file is saved. The authors can save the .dotm file 
anywhere you want. Finally, the ‘IJMSA’ tab is added. 

If you have troubles such as malfunctions in some buttons 
when the new tab is added, they should be caused by macro 
settings. Go to the ‘Developer’ tab, and click the ‘Macro 
Security’ button. Then select ‘Disable all macros with 
notification.’ This option warns you like ‘Macro has been 
disabled...’ when new templates or add-ins are read into the 
document. If you see the message of macro being disabled, you 
also see the ‘Enable macros’ button just on the right side of the 

message. Select this button. Now the IJMSA tab is activated and 
added. Unfortunately, the authors must enable the macros every 
time when the file is opened due to the macro security setting. 
But the editorial board does not recommend selecting the last 
option at the ‘Macro Settings’, i.e. ‘Enable all macros (not 
recommended, potentially dangerous code can run)’ due to 
security reasons. 

After enabling the ‘IJMSA’ tab, the page layout is 
automatically set up, that is, margins of top, bottom, left and 
right, header and footer distances, font size and names and so 
on. Header and footer are also inserted but the authors do not 
need to take care of them. The editorial board will set them 
correctly after accepting the manuscript. The standard fonts are 
‘Times New Roman’ and ‘Symbol.’ If you use Macintosh 
computers or other machines, some of these fonts may not be 
installed. In such cases, please contact the editorial office. The 
office will provide customized version of the .dotm file. In 
addition, if you find any bugs or have any proposals for 
improvements, please contact the editorial office, too. 

2. Structures 

2.1 Reserved Lines 
The manuscript has structures. The first two lines at the first 

page are reserved for the editorial board. These lines are used 
for expressing the kind of articles. 

1 Affiliation of the author group #1, Street-number Area, City, Prefecture 000-0000 Japan 
2 Affiliation of the author group #2, 2-3 Abc 1-chome, Def city, Vwxyz 000-0000 Japan 
(E-mail: Corresponding.Author@university.ac.jp) 
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2.2 Title Lines 
The title lines are located just after the reserved lines. The 

number of lines is not limited but concise title is strongly 
recommended. After the title lines are completed, please select 
all of the title lines and press the ‘Title’ button  in the ‘IJMSA’ 
tab. If multiple title lines are not selected, only one line will be 
reformatted. After pressing the  button, the title lines format is 
modified to a centering format with bolded 14 pt-sized fonts. 
The title abbreviation is automatically set from the first line of 
the title. This abbreviation is used as a header at odd pages 
except for the first page. The words from the first word to the 
word beginning with a capital letter near the end of the first line 
are selected as the abbreviation. However, the automatic 
abbreviation may not be suitable for the authors. In such cases, 
you can manually define the abbreviation by selecting some 
words of the title and then pressing the ‘Short Title’ button  in 
the ‘Special’ group. Please pay attention that selection of 
multiple lines is not allowed for the short title. To confirm the 
abbreviation, press the ‘Reinit’ button  in the ‘Control’ group. 

The authors will find the undo history named ‘Set Title’ 
appears in the undo buffer after pressing the ‘Title’ button. This 
is provided to undo by one click or one ‘Ctrl+z’ operation. 
Although MS-Word 2010 basically has no limitation on how 
many operations can be stored in the undo buffer, one undo 
operation will be convenient to the authors. If you meet any 
troubles on undo operations, please try to press the ‘ClearUndo’ 
button . This button clears the undo buffer completely. Pay 
attention that the authors cannot undo this operation. So please 
use the  button carefully. 

2.3 Author Lines 
The author lines are placed after the title lines. The first name 

should be first and the family name is the last. The first name 
should not be abbreviated. Middle names can be abbreviated. 
The first letter of the first name should be capitalized while all 
letters of the family name should be capitalized. Each author 
name has superscripted numerals without parentheses to 
represent the affiliation if multiple authors exist. The numerals 
should be separated by commas if the author has multiple 
affiliations. In a single author case, any marks are not required. 
The command button to add the numerals are not provided. 
Hence, you should add them manually. After completion of the 
author lines, select the whole author lines and then select the 
‘Author’ button . After pressing the button, an author 
abbreviation is automatically registered. The abbreviation is 
used as a header at even pages except for the first page. The 
undo history name is ‘Set Author.’ You can confirm the 
abbreviation by pressing the ‘Reinit’ button . 

2.4 Affiliations 
Actually, the place of the affiliation lines is not limited if the 

lines are placed in the first page. However, we recommend the 
affiliations are described just after the author lines. Each 
affiliation line must begin with numerals corresponding to the 
superscripted numerals at the author lines. One or more spaces 
will be required between the numerals and the first word. After 
finishing describing the affiliations, select all of the lines and 
press the ‘Affil.’ button . The affiliation lines will move to the 
bottom of the page and reformatted. The author receives one 
message like ‘Please replace dummy e-mail address…’ After 
pressing the ‘OK’ button, the dummy e-mail address will appear 
after the affiliation lines. Please edit the address line and ensure 
an appropriate address of the corresponding author. The undo 
history name is ‘Affiliation.’ 

2.5 Abstract 
An abstract should be concise enough to represent the 

contents of the manuscript. The number of letters (not words) 
should be 910 letters or less. The authors should count the 
number of letters by using the ‘Word Count’ function at the 
‘Review’ tab. There is no need to describe the abstract title like 
‘Abstract.’ The abstract title is automatically inserted after 
pressing the ‘Abstract’ button . The abstract should consist of 
one paragraph without any citations in principle. If referring the 
past researches is indispensable, the authors can add the special 
format as (Authors Year). After describing the abstract, select 
the abstract region and press the ‘Abstract’ button. You can get 
back by selecting the undo history named ‘Set Abstract’ or redo 
by selecting another region and by pushing the button . 

2.6 Keywords 
Keywords representing the contents are required. The 

keywords should be placed just after the abstract. The authors 
are requested to describe keywords only without a header like 
‘Keyword(s).’ The format is modified after pressing the 
‘Keywords’ button . The cursor must be located somewhere at 
the keywords line. The header of ‘Keyword(s)’ is automatically 
inserted. This is the last line in the title section. Therefore, after 
pressing the ‘Keywords’ button, the section separator is inserted 
after the keywords line and the following paragraphs are 
formatted in two columns. The undo name is ‘Set Keywords.’ 

2.7 Sections 
Sections are started with section headers. The section headers 

have three levels, that is, the section beginning with the section 
number like 1., the sub-section like 1.1, and the sub-sub-section 
like 1.1.1. The period should not be placed at the last of the 
section numbers of the sub-sections and sub-sub-sections. The 
section number must be separated by one or more spaces from 
the text of the section header. Otherwise, the buttons ‘1.’ , 
‘1.1’  and ‘1.1.1’  will not work correctly. The undo history 
names are ‘Set Section’, ‘Set Subsect’ and ‘Set Subsubsect.’ The 
button ‘1.’ is also used for the Appendices. 
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2.8 Body Texts 
Body texts start just after a section, sub-section or sub-sub-

section header. One or more spaces before the first word are 
required to represent a beginning of a new paragraph. By 
pressing the ‘Body’ button , the one or more spaces are 
replaced to the first line indent. If the authors do not want to 
insert the first line indent, for example, just after equations, no 
space should be placed at the beginning of the line. The undo 
name is ‘Set Body Text.’ Please pay attention that the fonts are 
set to ‘Times New Roman’ by pressing the ‘Body’ button in the 
body texts. If you use another font such as ‘Symbol’ in the texts, 
you must set the font correctly again after pressing the button . 
To avoid this, use of inline equations instead of symbol fonts 
may be convenient. 

2.9 Acknowledgments 
Acknowledgments are placed after all of the main texts. The 

authors describe the texts for acknowledgments without a 
section header like ‘Acknowledgments.’ Select the 
acknowledgment text region and press the ‘Acknowledge’ 
button . The section header is automatically inserted. If you 
want to insert the acknowledgment header before writing texts, 
insert blank lines and then set the cursor position at the blank 
lines. The undo name is ‘Acknowledge.’ 

2.10 References 
References are located after the acknowledgments. To make a 

reference list, the authors should input required data by pressing 
the ‘Ref Data’ button . After pressing the button, a small 
window asking types of references will pop up. Please choose 
one the options and then a new dialogue box will open. Almost 
all of the data are required but you can leave ‘Volume’ and ‘No.’ 
boxes null in the journal case. The ‘Volume’, ‘Conference 
Location (City)’ and ‘Month’ boxes in the proceedings dialog 
box, and the ‘Editors’, ‘Chapter/Section’, ‘First Page’ and 
‘Publisher’s Location’ boxes in the book case can be left null 
without errors, though the information should be described as 
much as possible. If there is no reference yet, the reference 
header is inserted at the appropriate position. Basically, full 
members of the authors are required except for the case that the 
author list is officially abbreviated like ‘J. Smith et al.’ Note that 
the first and middle names are abbreviated by their initials. 

To cite the reference, the ‘Reference’ button  is used. After 
pressing the button, the reference list will open. This list is 
automatically generated from the information in the reference 
section. After pressing the button, the reference list will open. 
Select the check boxes as you need. The superscripted numeral 
with a right parenthesis will be inserted as a citation just at the 
cursor position like this 1), this 1‒3) or this 1, 3, 4). The undo names 
of ‘Ref Data’ and ‘Reference’ are ‘Input Ref’ and ‘Insert Ref,’ 
respectively. Examples of references are shown near the last of 

this document. 
At present, other tools such as EndNote are not supported but 

these may be functional. However, if the authors use such tools, 
press the ‘Ref Data’ button once to insert the reference header 
and cancel the dialogue box. In addition, the editorial board 
recommends that you should use the provided function at least 
once to know the reference format for the IJMSA. 

2.11 Appendices 
Appendices are placed after the references. The authors are 

asked after pressing the ‘Append’ button  whether the number 
of appendices is one or more. After selection, the Appendix 
header will appear. After this header, you may describe similar 
ways to the body texts. The authors can use the ‘1.’ button  if 
they need to divide the texts to several parts. Since the text 
format is the same as the usual body text, you can also use the 
‘Body’ button  for the texts. The undo name is ‘Appendix.’ 

2.12 Received and Accepted Dates 
The last line represents the received and accepted dates. This 

information is set by the editorial office. Therefore, please do 
not touch this line. 

3. Specials 

3.1 Figures and Tables 
Figures and Tables should be placed at the top or bottom of 

pages. Each figure or table requires a caption beginning with the 
word ‘Fig.’ or ‘Table.’ The caption is placed before the table, 
while it is placed after the figure. In the table cases, select both 
the caption and table, and then press the ‘Table’ button . After 
that, the authors are asked the table location, the top or bottom. 
The first priority is the top place. The beginning word ‘Table’ 
and the following table number are changed to the bold faces. 

 

Fig. 1 Figure caption 

Table 1 Table caption 
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The rules are also reformatted to the JASMA style. The figure is 
very similar to the table, that is, select the figure and caption and 
press the ‘Figure’ button . The beginning word ‘Fig.’ and the 
following figure number are also changed to the bold faces. 
Examples of a figure and table are shown in Fig. 1 and Table 1, 
respectively. The undo history names are ‘Set Figure’ and ‘Set 
Table.’ 

At present, the cross reference is not supported and may not 
work as the authors intend. Therefore, you should refer the 
figures and tables manually in the body texts. In the body texts, 
‘Figure’ or ‘Table’ is used if it appears at the first word of the 
sentence, while ‘Fig.’ or ‘Table’ is used except for the first word 
of the sentence. The word ‘Figure’, ‘Fig.’ or ‘Table’ and the 
following numerals should have the bold faces, for example, 
‘Fig. 1’ or ‘Table 1.’ To assist the reference description, each 
figure or table has a bookmark, which makes a quick jump to its 
location. The bookmark names of figures and tables are ‘fig_*’ 
and ‘tbl_*’, respectively, where the asterisk represents the 
numeral corresponding to the figure or table number. To access 
the bookmark, go to the ‘Insert’ tab. The authors will find the 
‘bookmark’ button in the ‘Link’ group. The bookmark is 
assigned to the text box consisting of a figure or table with a 
caption, though the boundary lines of the text box are invisible. 
If the text box is deleted, the assigned bookmark is also deleted. 
However, if only the figure, table or caption is deleted or edited, 
the bookmark is maintained for authors’ convenience. 

Please pay attention that anchors appear when the figures and 
tables go floating by using the text box. The anchor behavior is 
often inconvenient for the authors. To prevent any unexpected 
behavior, the editorial board strongly recommends moving the 
anchor to a more suitable position (less influence position on 
edits, for example, somewhere in the region where the 
reformatting is finished) by dragging the anchor before do 
anything. In addition, locking the anchor may be convenient. A 
command button to lock the anchor is not provided since MS-
Word has this function. 

3.2 Equations 
MS-Word 2007 and later versions have a new equation 

environment being very similar to the LaTeX equation 
environment. This function is located at the ‘Equation’ button in 
the ‘Insert’ tab. Unfortunately, the equation environment is not 
very good as compared with the LaTeX. For example, MS-Word 
cannot handle display-style formulas with equation number 
correctly. Therefore, it is required a little tricky method to 
realize that. The editorial board provides an equation 
environment in combination with a tabular environment as 
shown in Eq. (1). To use this function, press the ‘Equation’ 
button . To refer the equation, use ‘Equation’ for the first word 
of the sentence or ‘Eq.’ for the others. To refer the multiple 
equations, use ‘Eqs.’ instead of ‘Eq.’ Please pay attention that 

‘Eq.’ or ‘Equation’ and the following numerals do not have bold 
faces. The cross reference for the equation also does not work 
fine. Therefore, the manual reference is needed as same as the 
figure and table cases. The bookmarks named ‘eq_*’ is also 
provided for authors’ convenience. Since the bookmark is 
assigned not to the equation but to the table capsuling the 
equation, you can edit equations freely. However, do not touch 
the equation numbers to renumber them. For that purpose, 
please use the ‘RenumEq’ button . This function also 
reassigns the bookmark to maintain the consistency. Please pay 
attention that the cursor must be placed before the target 
equations for renumbering. The undo names are ‘Set Equation’ 
and ‘Renum Eqs.’ Another equation environment named 
‘SubEqn’  is provided to express the equations with sub-
numbers (similar to subequations environment in AMS LaTeX) 
like (1a), (1b), and so on. The undo name is the same as the 
usual equation, ‘Set Equation.’ Examples of an equation and 
sub-equations are shown in Eq. (1), Eqs. (2a) and (2b), 
respectively. 

𝑥2
𝑑2𝑦
𝑑𝑥2 + 𝑥

𝑑𝑑
𝑑𝑑 + (𝑥2 − 𝛼2)𝑦 = 0 (1) 

𝑑
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�
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∞

𝑛=0

 (2b) 

4. Shortcut Keys 

The authors can assign some functions to keyboard shortcuts 
by pressing the ‘Key Bind’ button  in the ‘Control’ group. 
After pressing the button, a new window will appear. The icons 
being same as those in the ribbon are placed in the window. If a 
specified shortcut is already defined, you will be warned. The 
warnings will appear just below the text box. To delete the 
assignment, delete the existent character in the text box and 
press ‘OK.’ The authors can confirm the shortcuts in the MS-
Word option menu. Select the ‘Customize Ribbon’ and then 
select ‘Customize...’ just right to the ‘Keyboard Shortcuts:’ tag. 
Select macros and change ‘Normal.dotm’ to your document 
name such as ‘abc.docx.’ The authors will find macros 
beginning the name ‘JASMA.’ Select a macro and they can 
confirm the shortcut. However, the editorial board does not 
recommend the direct edit in this menu because the ‘Key Bind’ 
function does not detect the edit. 

5. Itemization and Enumeration 

To describe itemizations or enumerations, please use the 
‘Item’  or ‘Enum’ button . Before pressing the button, you 
must set the cursor somewhere on a target line or must select a 
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region. Multiple lines are acceptable. Examples are shown 
below. 

● This is an itemization. 

(1) This is an enumeration. 

Acknowledgments 
Authors should place acknowledgements here. The cursor 

should be located at a target paragraph. If you want to insert the 
acknowledgment header before writing any texts, please insert a 
blank line and set the cursor on the blank line. After clicking the 
‘Acknowledge’ button , the acknowledgment header will be 
inserted. In addition, the text format will be changed to an 
appropriate one. 
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Appendix 

If authors need to describe appendices, please write them 
here. By pressing the ‘Appendix’ button , the headers for 
appendices will be inserted above the paragraph where the 
cursor is located. This behavior is quite similar to that of the 
‘Acknowledge’ button. There is no function of seeking whether 
the appendix header already exists or not. Hence, the authors 
have to pay attention to usage of this button. If you need to 
describe multiple appendices, you must use ‘Appendix’ + 
numerals + ‘header title’ or ‘Appendix’ + numerals as each 
appendix header. One or more spaces should be inserted 
between the words. 
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